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Document History 

 

The following table provides an overview of the most important document changes. 

Version Important Changes 

1 Initial version  

2 Roles and log objects provided with FP01 added 

3 Data archiving functionality 

  

  

Table 1: Most important document changes 
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1 Getting Started 

 This guide does not replace the daily operation handbook that we 

recommend customers create for their specific production 
operations. 

 

1.1 About this Guide 

This guide provides a starting point for managing your SAP S/4HANA Utilities extensions for meter to 
cash processes by PROLOGA and maintaining and running them optimally. It contains specific information 
for various tasks and lists the tools that you can use to implement them. This guide also provides 

references to the documentation required for these tasks, so you will also need to refer to other 
documentation like the Master Guide or Configuration Guides.  

 

 You always find the most up-to-date version of this guide at the 
SAP Help Portal under https://help.sap.com -> SAP S/4HANA 
Utilities extensions for meter to cash processes 

 

 

Because the add-on is an extension for SAP® S/4HANA for Utilities, you should also read the 

documentation Technical Operations for SAP® NetWeaver on the SAP® Help Portal under 
https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP S/4HANA. 

 

 Several types of information that is valid for SAP® S/4HANA are 

also applicable for this add-on. For your convenience this 
information is copied into this guide.  

1.2 Important SAP Notes 

Please read the following SAP® notes before you start implementing the add-on 

 

SAP Note Number Title 

2481257 Composite SAP note for SAP S/4HANA Utilities extensions for meter to cash 
processes by PROLOGA 

  

  

  

  

Table 2: Important SAP Notes 

 

https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
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2 System Landscape Information 

The add-on is written in ABAP and runs on top of SAP® S/4HANA for Utilities. That means it will be 

installed in your SAP® system and requires no additional server or database components.  

 

SAP S/4HANA

ABAP Server

IS Utilities

SAP HANA DB

Web AS ABAP 7.51

S/4 Core 100

PROLOGA add-on for S/4HANA

 

Figure 1: Add-on deployment on S/4HANA 

For the Mobile On-Site Billing solution, it also is possible to run the application in a side-by-side approach 
as depicted below. In this approach, the IS-U/CCS functionality is located in the SAP® S/4HANA IS-U/CCS 

system while the Mobile On-Site Billing functionality is located in dedicated second system.  

Thanks to the separated systems this second option provides better performances to IS-U and Mobile On-
Site Billing processes. 
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Figure 2: Side-by-Side deployment 
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3 Monitoring 

SAP® provides you with an infrastructure to help your technical support consultants and system 

administrators effectively monitor your system landscape. 

 

This infrastructure can be used to monitor SAP S/4HANA Utilities extensions for meter to cash processes 
by PROLOGA as well. 

 

For more information about monitoring topics, see the SAP Help Portal under 

https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP S/4HANA -> 

Technical Operations for SAP NetWeaver -> Solution Life Cycle Management -> Solution Monitoring. 

 

For more information about monitoring with SAP Solution Manager, see the SAP Help Portal under 
https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP S/4HANA Technical 
Operations for SAP NetWeaver -> Solution Life Cycle Management -> Connecting a Technical System to 
SAP Solution Manager. 

3.1 Alert Monitoring with CCMS 

SAP S/4HANA Utilities extensions for meter to cash processes by PROLOGA uses the standard SAP 
NetWeaver monitoring tools, including the Computing Center Management System (CCMS). This tool 
allows you to monitor your system landscape centrally. 

Alerts form a central element for monitoring. They quickly and reliably report errors (such as values 
exceeding or falling below a particular threshold value or that an IT component has been inactive for a 
defined period of time). These alerts are displayed in the Alert Monitor of the CCMS. 

 

For more information about CCMS, the Alert Monitor, see the SAP Help Portal under 
https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP S/4HANA -> 
Function-Oriented View -> Solution Life Cycle Management -> Solution Monitoring -> Monitoring in the 
CCMS. 

3.2 Trace and Log Files 

Trace and log files are essential for analyzing problems. SAP S/4HANA Utilities extensions for meter to 

cash processes by PROLOGA uses the standard SAP® NetWeaver tools for tracing and logging. 

 

For more information about this topic, see the SAP® Help Portal under 
https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP S/4HANA Technical 
Operations for SAP NetWeaver -> Solution Life Cycle Management -> Application Log (BC-SRV-BAL). 

3.2.1 Log Objects for the add-on 

 

Object Sub object Description 

/PLGA/MOB  General logging object PROLOGA Mobile OnSite Billing 

 /PLGA/EXPORT_CCS Log object for export processes to the IS-U/CCS system 

/PLGA/ECF  Log object for ECF Check Framework 

/PLGA/ECV  Log Object for EDM calorific value extension 

/PLGA/EU3  Log Object for EU3 Data Import 

/PLGA/SPF  Log Object for Simple Process Flow Instances  

Table 3: Log Objects of the add-on 

https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
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3.3 Process Monitors 

SAP S/4HANA Utilities extensions for meter to cash processes by PROLOGA uses the standard SAP 
NetWeaver process monitoring tools. 

 

For more information, see the SAP Help Portal under https://help.sap.com_SAP_S4HANA_ON-
PREMISE_1909  -> SAP NetWeaver for SAP S/4HANA -> Function-Oriented View -> Solution Life Cycle 
Management -> Solution Monitoring -> Process Monitoring with PMI (Process Monitoring Infrastructure). 

https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
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4 Management of SAP S/4HANA Utilities extensions for meter to cash 
processes by PROLOGA 

SAP provides you with an infrastructure to help your technical support consultants and system 
administrators effectively manage all SAP components and complete all tasks related to technical 
administration and operation. 

 

For more information about operational topics, see Technical Operations for SAP NetWeaver at the SAP 

Help Portal under https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP 

S/4HANA.  

4.1 Starting and Stopping 

SAP S/4HANA Utilities extensions for meter to cash processes by PROLOGA does not require any specific 
task when the system gets started or stopped. 

 

You can use the SAP Management Console to stop and start SAP systems based on SAP NetWeaver, 

including SAP S/4HANA. 

 

For more information on the SAP Management Console, see the SAP Help Portal under 
https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP S/4HANA -> 
Technical Operations for SAP NetWeaver -> Solution Life Cycle Management -> Starting and Stopping 

SAP NetWeaver AS for ABAP and Java.  

4.2 Software Configuration 

Before you can use the extensions delivered with this add-on you have to do the basic configuration for 
respective functionality.  

 

The configuration guides for the different extensions can be found on the SAP Service Marketplace at: 
https://help.sap.com search for -> SAP S/4HANA Utilities extensions for meter to cash processes. 

 

 The add-on provides extensions for the SAP® industry solution 
SAP® S/4HANA for Utilities. Before you start to configure this add-
on you have to configure the standard business processes first. 

  

For information about how to do the configuration for SAP® 
S/4HANA, see the guide Getting Started With SAP® S/4HANA at 
the SAP Help Portal under 

https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909  -> 
Getting Started. 

4.3 Backup and Restore 

You need to back up your system landscape regularly to ensure that you can restore and recover it in 
case of failure. 

 

To use an appropriate backup-and-restore method is one of the most important tasks of the system and 

database administrator. However, there is no general recommendation for such a method, since it 
depends on several factors, such as: 

• Disaster recovery concept 

• Maximum permissible downtime during restore 

https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
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• Amount of data loss that can be tolerated 

• Available budget 

 

For more information about backup and recovery, see: 

• The SAP® Help Portal under https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP 
NetWeaver for SAP S/4HANA -> Technical Operations for SAP NetWeaver -> Solution Life Cycle 
Management -> Backup and Recovery. 

• SAP® HANA Technical Operations Manual at the SAP® Help Portal under 
http://help.sap.com/hana_platform -> System Administration. 

4.4 System Copy 

Since the add-on is fully integrated in the SAP® system, you do not have to perform additional steps for 

creating a system copy. For a homogeneous system copy, the standard procedures of SAP NetWeaver 
apply. 

 

For more information about backup and recovery, see SAP® Help Portal under 
https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP S/4HANA -> 
Technical Operations for SAP NetWeaver -> Solution Life Cycle Management -> System Copy. 

4.5 Load Balancing 

SAP S/4HANA Utilities extensions for meter to cash processes by PROLOGA uses the standard SAP 
NetWeaver functions for load balancing. 
 

For more information about this topic, see Technical Operations for SAP NetWeaver at the SAP® Help 
Portal under https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP 
S/4HANA.  

4.6 Data Archiving and Data Aging 

For the Data archiving / data aging functionality, please refer to the configuration guide. 

https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
http://help.sap.com/hana_platform
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
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5 User Management 

SAP S/4HANA Utilities extensions for meter to cash processes by PROLOGA generally relies on the user 

management and authentication mechanisms provided with the SAP® NetWeaver platform, in particular 
the SAP® NetWeaver ABAP Application Server, and the SAP® HANA Platform. Therefore, the security 
recommendations and guidelines for user administration and authentication as described in the Security 
Guides for SAP® NetWeaver and SAP® HANA Platform also apply to SAP® S/4HANA. 

 

For more information, see: 

• Security Guide for SAP® NetWeaver at the SAP® Help Portal under 

https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 ->  SAP NetWeaver for SAP S/4HANA 

• SAP® HANA Security Guide at the SAP® Help Portal under 
http://help.sap.com/hana_platform/Security 

 

In addition to these guidelines, information about user administration and authentication that specifically 
applies to SAP® S/4HANA can be found in the Security Guide for SAP® S/4HANA at the SAP® Help Portal 

under https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> Product Documentation. 

5.1 Role Concept 

The add-on contains a pre-defined set of roles for common business scenarios which can easily be 
adapted to your specific needs. 

 

Role Profile 

/PLGA/FIORI_LAUNCHPAD_USER /PLGA/FLPU 

/PLGA/MOB_CUSTOMIZING /PLGA/MOBC 

/PLGA/MOB_FIORI /PLGA/MOBF 

Table 4: /PLGA/ roles and their authorization profile names 

For technical reasons these roles are only imported fully correctly into the client 000 when the PROLOGA 
add-on is installed. In other clients, the authorization profiles are usually not generated automatically 

during the installation. Therefore, it is necessary to manually generate the authorization profiles 
belonging to these roles. We recommend the following course of action for the system administrator in 
order to make the delivered roles fully usable also in other clients. These actions should be performed in 

that client of the development system where development and customizing work is usually executed. 

 

1. Enter transaction PFCG and choose one of the /PLGA/ roles listed above. Switch into editing 
mode. 

2. Choose the tab "Authorizations" and check the name of the authorization profile associated with 
the role. If the authorization profile has a name which deviates from the official standard profile 
name shown in the above table, then delete that wrongly named authorization profile. 

3. Click on the button "Change Authorization Data". You will be displayed the first level of a tree-
like structure containing all authorizations belonging to the chosen role. You need not change 
any of the existing authorizations. 

4. Save the role. If the system asks you to enter a name for the authorization profile, then enter 
the official standard profile name shown in the above table. 

5. Generate the authorization profile and return to the preceding window. 

6. Check if the authorization profile now has the correct name and that its status is "Authorization 
profile is generated". This should be the case now. 

7. Generate the authorization profiles with the correct names for all other /PLGA/ roles. 

8. Check and, if required, adjust the assignment of the /PLGA/ roles to users. 

https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
http://help.sap.com/hana_platform/Security
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
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9. Include all /PLGA/ roles in a customizing transport request. You can then transport these roles 
with the usual transport tools into all relevant clients in all relevant SAP systems in your 
landscape. 

 

Then all /PLGA/ roles should work correctly in all relevant clients. 

 

Of course, you can also copy a /PLGA/ role into a new role with a name chosen by you, and then you can 
change any details in the role as desired. 

 

In the following paragraphs, the /PLGA/ roles delivered with the add-on are described in a more detailed 

way. 

5.1.1 Role /PLGA/FIORI_LAUNCHPAD_USER 

The role /PLGA/FIORI_LAUNCHPAD_USER grants a user the general authorizations for using the Fiori 
launchpad. The authorizations contained in this role constitute basic prerequisites for using Fiori apps in 
the Fiori launchpad. 

5.1.2 Role /PLGA/MOB_CUSTOMIZING 

The role /PLGA/MOB_CUSTOMIZING allows a user to work with customizing transactions for the Mobile 

On-site Billing area. 

5.1.3 Role /PLGA/MOB_FIORI 

The role /PLGA/MOB_FIORI allows a user to work with Mobile On-site Billing apps in the Fiori launchpad. 
This role is only useful in combination with the role /PLGA/FIORI_LAUNCHPAD_USER. A user needs both 

roles, /PLGA/FIORI_LAUNCHPAD_USER and /PLGA/MOB_FIORI, for being able to enter the Fiori 
launchpad and to work with the Mobile On-site Billing apps there. 
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6 Business Continuity and High Availability 

The term business continuity covers all activities performed by system administrators to ensure that 

critical business functions are available to system users. Strategies for high availability are a subset of 
business continuity activities, but business continuity is not limited to high availability. Other activities 
that relate to business continuity include: 

• System backup and archiving 

• System updates with minimum downtime 

 

SAP S/4HANA Utilities extensions for meter to cash processes by PROLOGA uses the standard SAP® 

NetWeaver functions for high availability and business continuity. 

For more information about these topics, see: 

• Technical Operations for SAP® NetWeaver at the SAP® Help Portal under 
https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP S/4HANA 

• SAP® HANA Technical Operations Manual at the SAP® Help Portal under 
http://help.sap.com/hana_platform -> System Administration 

 

https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
http://help.sap.com/hana_platform
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7 Software Logistics and Change Management 

The tools and processes in Software Logistics help you to manage the system landscape in all lifecycle 

phases. Besides initial implementation of an application, the tools also support on-going system 
optimization and adaptation to evolving demands, as well as implementing additional functions.  

 

 Some software logistics tools are delivered and regularly updated 
with the Software Logistics Toolset. For more information about 
these tools, see the documentation on the SAP® Help Portal under 

http://help.sap.com/sltoolset. 

 

Change Management standardizes and automates the distribution of software in system landscapes. 

For more information, see the SAP® Help Portal under https://help.sap.com_SAP_S4HANA_ON-
PREMISE_1909 -> SAP NetWeaver for SAP S/4HANA-> Technical Operations for SAP NetWeaver -> 
Solution Life Cycle Management -> Software Logistics. 

7.1 Change and Transport Management  

SAP S/4HANA Utilities extensions for meter to cash processes by PROLOGA uses the SAP NetWeaver tool 
Change and Transport System (CTS) to organize development projects in ABAP Workbench and 
customizing, and to then transport the changes between the SAP® systems in your system landscape. In 
addition to ABAP objects, you can transport non-ABAP objects and non-SAP applications in your system 

landscape. 

 

For more information about the CTS tool, see Technical Operations for SAP® NetWeaver at the SAP® Help 

Portal under https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP 
S/4HANA. 

7.2 Support Packages and Patch Implementation 

You can find detailed information about the released support packages for SAP S/4HANA Utilities 
extensions for meter to cash processes by PROLOGA on the Service Marketplace at: 
https://help.sap.com-> Support Packages and Patches-> Search for Support Packages and Patches 
(search for PROLOGA). 

 

For more information about the tools for implementing patches, see also the SAP® Help Portal under 
https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP S/4HANA -> 
Technical Operations for SAP NetWeaver -> Solution Life Cycle Management -> Software Logistics. 

7.3 Release and Upgrade Management 

Corrections for SAP S/4HANA Utilities extensions for meter to cash processes by PROLOGA are available 

in support packages. 

 

http://help.sap.com/sltoolset
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
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8 Troubleshooting 

For more information about troubleshooting for SAP® NetWeaver based systems, see the SAP® Help 

Portal under https://help.sap.com_SAP_S4HANA_ON-PREMISE_1909 -> SAP NetWeaver for SAP 
S/4HANA -> Technical Operations for SAP NetWeaver -> Solution Life Cycle Management. 

 

 

 

 

 

 

https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
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9 Support Desk Management 

You can set up problem resolution procedures tailored to your requirements. The procedure should 

integrate your business users, internal support personnel, partners and SAP® support. 

9.1 Remote Support Setup 

If you want to use SAP® remote services (for example, SAP® EarlyWatch or Remote Consulting), or if you 
would like to permit an SAP support consultant to work directly in your system to make a more precise 

problem diagnosis, then you need to set up a remote service connection. 

 

For more information about setting up remote service connections to SAP®, see the SAP® Support Portal 

under https://help.sap.com and the SAP® Help Portal under https://help.sap.com_SAP_S4HANA_ON-
PREMISE_1909 -> SAP NetWeaver for SAP S/4HANA -> Technical Operations for SAP NetWeaver -> 
Solution Life Cycle Management -> Remote Support Setup.  

9.2 Problem Message Handover 

SAP S/4HANA Utilities extensions for meter to cash processes by PROLOGA uses the functions of the 
SAP® Solution Manager to create internal support messages and to forward them to SAP®. 

 

For more information, see the SAP® Help Portal under http://help.sap.com/solutionmanager -> SAP 

Solution Manager 7.1 -> Application Help -> SAP Engagement and Service Delivery. 

 

To send problem messages to SAP®, use the relevant application component in the SAP® application 
component hierarchy. 

 

For SAP S/4HANA Utilities extensions for meter to cash processes by PROLOGA the application 
component is XX-PART-PLG-UTL. 

 

  

 

 

https://help.sap.com/
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
https://help.sap.com/viewer/product/SAP_S4HANA_ON-PREMISE/1909/en-US?task=discover_task
http://help.sap.com/solutionmanager/
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